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Tabs3 Billing Getting Started Guide
Congratulations! You’ve made the decision to work with Tabs3 Billing. Now, let us show you how to get started
and where to go when you need more information.
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Before You Start
Before you can get started, you need to install Tabs3 Billing.

Installation
More Info – Installation
Training Video

l Tabs3 Billing Basics

Tabs3 Software Pre-Install Guide
Tabs3 Software Post-Install Guide

l Tabs3.com/docs

If you have not yet installed Tabs3 Billing, it’s easy to do.
Follow the instructions provided in the Pre-Install Guide
and Post-Install Guide. These installation guides can be
accessed at Tabs3.com/docs.

Tip: During the installation of the software, you will be
asked if you want to install the Starter Data. We
recommend installing Starter Data for a faster start.
Starter data includes transaction codes, statement
templates, categories, and more.

Starting Tabs3 Billing
1. From the Windows desktop, double-click the Tabs3 icon.
2. The Getting Started wizard will be displayed, allowing you to configure the Tabs3 Software.
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Setting Up Tabs3 Software
More Info - Customization
Help Topics

l Press F1 in the Customization window
l Click the Index tab and type “Client ID”

Training Video

l Tabs3 Billing Customization Settings

The Tabs3 Software Administrator Guide

l Tabs3.com/docs

The Guided Setup will walk you through
configuring the Tabs3 Software after first
installing the Tabs3 Software or when adding
licenses of new programs.

When first installing the Tabs3 Software, you will be
prompted to enter details about the firm and your
user information, which will be used to configure
your login account. Depending on the software
being installed, you will also be prompted to
determine the Decimal Places for your Key Type (by
how many matters you have for your clients),
configure bank information, and create a
timekeeper.

After completing the Guided Setup, you will automatically be logged in using the information you provided, and
the Tabs3 Software will be ready to use.

You can set up users in System Configuration, additional timekeepers in Tabs3 Billing, and customize your
configuration options after the Guided Setup is complete.

Step 1 – Configure Tabs3 Billing
After initial configuration, the defaults for Tabs3 Billing Customization are configured. However, additional
settings can be specified. The Customization window consists of several tabs.

▶ Configuring the Tabs3 Billing Customization Window

1. From the Quick Launch, search for and select “Customization.”
2. On theMain tab:

a. Note that the Key Type is set to Numeric and the Decimal Places are configured based on your
choice during the Guided Setup wizard. For additional information and steps for adjusting these
options, see Knowledge Base article R11049, “Changing the Key Type or Decimal Places.”

b. Specify the First Month of Reporting Year field. Most firms use January, but some firms’ fiscal year
starts with a different month. (Note: This month is different than the current reporting month.)

3. On the Options tab:
a. Specify whether you want statements numbered at the firm or client level in the Statement
Numbering field. (Note: We recommend numbering at the firm level so you can easily search by
statement number when entering payments.)

4. On the Rates tab:
a. If your state requires you to charge sales tax on services, expenses, or advances, select the

corresponding check box and enter the tax rate in the Rate 1 field.
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b. If you want to charge finance charge on past due balances, select the corresponding check boxes
and enter the annual rate in the Rate 1 field (e.g., enter 12.00 if you charge an annual finance
charge of 12% per year).

5. On the Client Defaults tab:
a. Specify the defaults that will be used when adding a new client.
b. If assessing sales tax, in the Sales Tax section, select the default sales tax rate.
c. If assessing finance charge, select the Assess Finance Charge check box, the Rate, and the number
of Days past due before the finance charge will be assessed.

6. Click to save the changes, and then close Customization.

Note: If the Customization window was previously saved, the window will not be opened automatically. Once
Customization is saved, the Key Type and Decimal Places fields will be dimmed and must be changed using the
Change Key Type program.

Entering Firm Information for Statements & Reporting Purposes
Use System Configuration to enter your firm’s name for reporting purposes. System Configuration includes
configuration for Tabs3 Billing, PracticeMaster, and Tabs3 Financials. Your firm’s name and address information
can also be used for statements.

1. Start Tabs3 Billing.
2. From the Application Toolbar, click the System

Configuration toolbar button as shown in the
image on the right.

3. The System Configuration window will be opened. From the Filemenu, point to Open and select Firm.
4. Enter your Firm’s name and other information.

5. Click to save the changes.
6. Close the System Configuration window.

More Info - Firm Information
Help Topics - Press F1 in the Firm Information window

The Tabs3 Software Administrator Guide

l Tabs3.com/docs

Tip: System Configuration is also used to create user
accounts and define privileges for individual users who
will be using the software.

Tip: Refer to the Statement Formatting Guide for more
information on customizing statements.

Step 2 – Add Timekeepers & Rates
Next, you need to set up timekeepers. Timekeepers are the individuals in your office whose time is billed to
clients.
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▶ To add timekeepers

More Info – Timekeepers & Rates
Help Topics – Press F1 in the Timekeeper window

Training Videos

l Working with Timekeepers
l How Rates Work

Billing Methods Guide – Hourly Billing

l Tabs3.com/docs

1. In the Quick Launch, search for and select
“Timekeeper Information.”

2. On the Timekeeper tab:
a. Press Ctrl+N to add a new timekeeper

number.
Tip:Most firms use “1” for the senior
partner.

b. Select the User who will be tracking time.
l If the user has not yet been created,
click the Add User link.

l Once specified, the contact name and initials are shown.
c. Click the drop-down arrow in the Level field to select the timekeeper level.
Tip: Additional levels can be defined via theMisc Desc tab.

3. In the Rates section:
a. Enter the timekeeper’s default hourly billing rate in the Rate 1 field.
b. You can use Rate 2 for a premium rate, discounted rate, court rate, etc. However, it is best to use

Rate 2 consistently for all timekeepers. For example, if Rate 2 is the court rate, make sure Rate 2 is
the court rate for all timekeepers. Enter any additional rates as desired.

4. Click to save the changes.
5. Add additional timekeepers as needed by repeating steps 2 through 4.

Tip: Custom billing rates can be set up at the client level. See the Billing Methods Guide for more information.

Note: The Administrator Guide and Client & Contacts Guide contain additional information about creating
users, timekeepers, and contacts.

Using Tabs3 Billing
Once you’ve set up your timekeepers and rates, you’re ready to add clients, fees, and costs, and then run
statements.

Step 3 – Add Clients
Clients are added to Tabs3 Billing using the Client program. When you add a client, a contact record is created
for the individual or organization. Contact records can also be used by other clients and matters.
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▶ To add clients

More Info - Clients & Contacts
Help Topics – Press F1 in the Client or Contact window

Training Video

l Getting Started with Clients

Clients & Contacts Guide

l Tabs3.com/docs

1. From the Quick Launch, search for and select
“Client Information.”

2. On the Address tab:
a. Press Ctrl+N to add a new client.

i. The New Client Record window will
be displayed. Select the desired
option for the Client ID you want to
use to identify the client.

ii. Click OK.
b. Enter the Client Name (e.g., Jones/Mary T. or United Insurance Company).
c. A Contact Information window will be displayed, allowing you to enter the address and phone

information for the contact. Enter the desired information and click to save the changes.
d. After saving the contact information, you are returned to the Address tab of the client file with the

contact information already filled in.
3. On the Setup tab, specify the desired Billing Category and Primary Timekeeper.
4. On the Billing Preferences tab, under Statement Delivery Options, double-click the first record in the

table. This is where you designate whether the client will receive a printed statement and/or an email
statement.

5. Click OK to close the Bill To Record window and then click to save the changes.

Tip:When entering information for a potential client, enter the information in a Contact record. Then, when the
contact becomes a client, use the contact record to populate the client record. You can access the Contact file by
clicking the People group on the All Actions tab group of the Home page and then clicking the Contact
Information icon, or by entering “Contact” in the Search Actions field of the Quick Launch pane.

Step 4 – Add Fees & Costs
Fees and costs are entered using the Fee and Cost programs.

▶ To add fees

More Info – Fees
Help Topics – Press F1 in the Fee window

Training Video

l Working with Fees

1. From the Quick Launch, search for and select “Fee
Entry.”

2. By default, the last accessed Client ID is used for
the default. Select the desired client by doing one
of the following:

l Press Enter to accept the selected Client ID.
l Enter a different Client ID.
l Click the drop-down button to select a different client from the Client Lookup window.

3. Press Enter or Tab in the Reference field to add a new fee.
4. Select the desired Timekeeper.
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5. Enter the desired Date.
6. Click the drop-down button in the Tcode field to select the desired transaction code. Transaction codes

represent a type of service or activity.
Tip: Tcodes are optional. If desired, use tcode 1 and enter your own description.
Tip: Right-click the Tcode field and select Edit Transaction Code to add or edit transaction codes.

7. Enter the Hours Worked. For example, 15 minutes would be entered as .25 hours.
8. After selecting the desired transaction code, the default description for that transaction code will be used

in the Description field. Edit this field as desired.
Tip: Use transaction codes or text macros to create commonly used phrases or paragraphs to aid in faster
data entry.

9. Click to save the changes.

Detail vs. Rapid Entry Mode
The Fee Entry program has a detail mode and a rapid mode. The steps above use the fields in Rapid mode. Let’s
take a look at Detail mode.

l While in the Fee window, click the Detail/Rapid button.

When in Detail mode, additional fields are shown above the Description including the Hours to Bill, Rate, and
Amount fields. Furthermore, additional fields are shown below the Description field including Category, Bill
Code, Rate Code, Status, Sales Tax, User ID, and Date Entered. When you are in Rapid mode, the text Rapid
Fee is shown in the title bar.

Fee Entry List
You can see a list of fee transactions by using the Toggle List button (or Alt+G). Notice that the transaction
you saved is shown in the list. If you want to edit the transaction, simply double-click the entry to retrieve it in

the data entry form. After making any changes, click to save the changes.

Recap of Hours
More Info – Recap of Hours
Help Topics – Press F1 in the Recap of Hours window

Training Video

l Using the Recap of Hours

The Recap of Hours window shows the cumulative
billable and non-billable hours and amounts for the
specified timekeeper on any given day. This makes it
easy for timekeepers to see whether any time entries
are missing.

l In the Quick Launch, search for and select “Recap of Hours;” or
l While in the Fee program, click the Recap of Hours button.

The first time you open the Recap of Hours window, you will be prompted to select the Timekeeper whose hours
you want to view. You can select a different timekeeper by clicking the icon.

Tip: In the Quick Launch, search for and select “Recap of Hours Report” to generated a printable report for any
time period. This report shows a calendar with the number of billable and non-billable hours for each day by
timekeeper.
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Verification Lists
When you close the Fee program, you will be provided the opportunity to print a Verification List. Verification
Lists are optional and include a list of the transactions that were entered, changed, or deleted during the session.
Verification Lists are also available for the Cost and Payment data entry programs.

Working with Costs
In Tabs3 Billing, costs are classified as expenses or advances. Expenses are “soft” or “indirect” costs, whereas
advances are “hard” or “direct” costs. Costs are classified differently for accounting and tax purposes. Examples
of expenses include photocopy expenses, long distance, postage, etc. Examples of advances include filing fees,
witness fees, medical costs, etc.

Tip: You can show expenses and advances separately on a statement, or you can combine them.

▶ To add costs

More Info – Costs
Help Topics – Press F1 in the Cost window

Training Video

l Working with Costs

1. From the Quick Launch, search for and select
“Cost Entry.”

2. Enter the desired Client ID.
3. Press Enter or Tab in the Reference field to add a

new cost.
4. Enter the desired Date.
5. Click the drop-down button in the Tcode field.

a. Notice that the list of transaction codes is different for costs. This is because each transaction code
is assigned a Fee, Expense, or Advance attribute when it is defined. Notice the Type column in the
Tcode Lookup window shows E or A, thus indicating whether the tcode is an expense or advance.

b. Select the desired tcode.
6. Notice the Units and Rate fields are available. These fields can be used for mileage or photocopies, for

example.
7. Enter the Amount.
8. Enter the Description.

9. Click to save the changes.

Like the Fee Entry program, you can use the Detail/Rapid button to toggle between Detail and Rapid Mode.
You can use the Toggle List button to hide or display a list of costs at the bottom of the window. When you
exit the Cost Entry program, you will be given the option to print a Cost Entry Verification List.

Step 5 – Run Statements
Once all fees and costs have been entered, you can run a statement for the client.
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▶ To run a statement

1. In the Quick Launch, search for and select “Generate Statements.”
2. On the Client tab, specify the desired clients for the beginning and ending Client ID, or leave these fields

blank to print statements for all clients.
3. On the Transactions tab, you can specify a cut-off date for fees and costs if desired.
4. On the Options tab, select Draft. We want to run a draft statement for review purposes.

Tip: Select the Print Reference Numbers check box to include reference numbers on statements to assist
with selecting individual transactions for editing purposes.

5. Click OK.
6. You can either print or preview the statement. Click Preview to review the statement before printing.

More Info – Statements
Help Topics

l Enter “Statements” on the Index tab and select
Overview

l Press F1 in the Generate Statements, Statement
Designer, and Statement Templates windows

Training Videos

l Statement Generation Basics
l Utilizing Statement Templates

Tabs3 Billing Statements Guide
Tabs3 Billing Statement Formatting Guide

l Tabs3.com/docs

Knowledge Base Article R11338 – Emailing Tabs3 Statements

l support.Tabs3.com/main/r11338.htm

When reviewing the statement in the Preview window,
you can easily modify any transaction by moving your
mouse over the transaction description, then clicking it
when it turns yellow. After saving any changes to the
transaction, you will be returned to the statement. Click
the Refresh button at the bottom of the Preview
window to refresh the statement with your changes.

Changing the Statement Format
Statement format is controlled by statement templates.
Each client is assigned a statement template for draft
statements and one for final statements. Tabs3 Billing
also includes a Statement Designer that provides the
ability to create customized page layouts for your
statements. Once designed, page layouts can be
applied to one or more statement templates.

Let’s say after reviewing the statement, you want to
change the format of the fees so it shows hours and rates. The statement format can be changed via the Client
file. However, if you still have the statement displayed in the Preview window, you can open the Client file by
moving the mouse over the Account No. at the top of the statement and clicking it when it turns yellow.

▶ To change the statement format

1. Open the Client File by doing one of the following:
l When previewing a statement, mouse over the Account No. at the top of the statement and click it
when it turns yellow.
…or…

l From the Quick Launch, search for and select “Client Information.”

2. On the Statement Options tab, right-click in the Draft Template field (or Final Template field) and
select Edit Statement Templates.
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3. On the Fee Format tab, in the Include section that is to the right of the Fee Format section:
a. Select the Rate check box.
b. In the Hours drop-down list, select Detail.

4. After making all changes to the statement template:
a. Press Ctrl+S to save the changes.
b. Close the Statement Template window.
c. Close the Client window.

5. Rerun the statement. If you are still in the Preview window, simply click the Refresh button to rerun the
draft statement.

Tip: Keep in mind that changing the statement template affects all clients that use that template.

Generate a Final Statement
Once you approve the draft statement, you must run a final statement. This can be accomplished by changing
the Statement Type from Draft to Final on the Options tab. Or, it can be run using the Pre-Bill Tracking
window.

▶ Generating a Final Statement via Pre-Bill Tracking

1. In the Quick Launch, search for and select “Pre-Bill Tracking.”
2. Highlight the desired Client ID.
3. Click the Reviewed button at the bottom of the window to indicate the statement was reviewed.
4. Click the Final Statements button to generate a final statement.
5. Click OK.

Pre-Bill Tracking
More Info – Pre-Bill Tracking
Help Topics – Press F1 in the Pre-Bill Tracking window

Tabs3 Billing Statements Guide – Tracking Statements

l Tabs3.com/docs

The Pre-Bill Tracking window makes it easy to track the
status of statements. When draft statements are run, a
statement record for that batch of statements is added
to the Pre-Bill Tracking window. As draft statements are
reviewed, you can mark them as reviewed or on hold.
You can then easily run final statements directly from
the Pre-Bill Tracking window for all statements that have been reviewed. The Pre-Bill Tracking window provides a
centralized location that shows the status of all pending statements.

Tip: Some firms prefer to use Detail Work-In-Process Reports (Reports | Work-In-Process | Detail Work-in-
Process Report) instead of draft statements to review information before billing. Running Detail Work-In-
Process Reports also adds statement records to the Pre-Bill Tracking window.

Step 6 – Update Statements
Now that the final statement has been generated, you must update the statement using the Update Statements
program. This process finalizes the statement and sends the information to accounts receivable and other
productivity reports.
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▶ To update a statement

1. In the Quick Launch, search for and select “Update Statements.”
2. If prompted to make a backup, click Yes.
3. After the backup completes, the Update Statements window will be displayed. Specify the desired Client

IDs you want to update, or leave the fields blank to update all final statements for all clients.
4. Click OK.

Step 7 – Print Accounts Receivable Report
When statements are updated, the information is also updated in accounts receivable and other reports. Let’s
look at an accounts receivable report.

▶ To print a Summary Accounts Receivable Report

More Info – Reports
Help Topics – Press F1 in the Accounts Receivable Report
window

Training Video

l Working with Reports

Tabs3 Billing Report Pack

l Tabs3.com/docs

1. In the Quick Launch, search for and select
“Summary A/R Report.”

2. On the Client tab, specify the desired client (or
leave the Client ID fields blank to select all
clients).

3. On the Options tab, select any desired options.
4. On the Format tab, select any desired options.
5. Click OK.
6. Click Preview when the Print Summary Accounts

Receivable Report window displays.
7. After you’ve finished viewing the report, click the Close button at the bottom of the Preview window. You

will be returned to the report window allowing you to run another report if desired.

Tip: There are additional accounts receivable reports available via the All Actions | Reports | A/R Reports
group on the Home page.
Tip: After opening any report window, press F1 while in the criteria selection window for the report. In the

heading bar of the help topic, click the icon. This icon opens the Tabs3 Billing Report Pack, which shows an
example of the report and provides detailed information for every item on the report.

Step 8 – Enter Payments
Upon receipt of a client’s payment, you need to enter a payment transaction.
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▶ To add payments

More Info - Payments
Help Topics - Press F1 in the Payment window

Training Video

l Working with Payments

1. From the Quick Launch, search for and select
“Payment Entry.”

2. Enter the desired Client ID.
Tip: Notice that the client’s accounts receivable
balance is shown at the bottom of the window
after specifying the Client ID.

3. Press Enter or Tab in the Reference field to add a new payment.
4. Enter the desired Date.
5. Click the drop-down button in the Tcode field and select the desired tcode.
6. Enter the Amount.
7. Enter the Description.

8. Click to save the changes.

Once the payment is entered, the accounts receivable automatically reflects the payment. However, in order to
process the payment, a final statement must be generated and updated that includes the payment. This typically
occurs when the next statement for the client is generated. If no other work will be performed for the client, then
you can run a payment-only statement.

Tip: You can run a report of all cash receipts. In the Quick Launch, search for and select “Cash Receipts Report.”

Step 9 – Matter Manager
The Tabs3 Billing Matter Manager shows client contact information, balance due information, work-in-process
information, the date of the last statement and payment, client funds and trust balances, and a list of recent
transactions and statements. You can launch the reports you run most often for individual clients. The
PracticeMaster button launches the Matter Manager in PracticeMaster, which provides quick access to other
matter related information.

▶ To launch the Matter Manager, do one of the following:

l Click the button on the toolbar.
l From the Filemenu, clickMatter Manager.
l In the Quick Launch, search for and select “Matter Manager.”
l Press Ctrl+M.

Resources
This Getting Started Guide provides you with the information you need to start using the software. There are
many other resources available to help you learn the software.
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Training Videos
The Tabs3 Software include numerous training videos to help you learn the software. Training video libraries can
be accessed via the Quick Launch by searching for and selecting “Training Videos.”

Help
Help is installed with the software and is easily accessed by pressing F1, by clicking the button, or in the Quick
Launch by searching for and selecting “Help Topics.” Help includes detailed information regarding specific
programs. Clicking the button opens Help for the window you are currently using. Many times, reading the
appropriate Help topic may be the fastest way to find your answer.

Tabs3 Billing Guides and Report Pack
There are multiple Tabs3 Billing guides and a Tabs3 Billing Report Pack installed with the software in PDF format.
Shortcuts are created during installation. In the Quick Launch, search for and select “Documentation” for a list of
all available Tabs3 Software Documentation. The guides include information on basic setup and use of the
software. Tabs3 Billing has dozens of reports and the Tabs3 Billing Report Pack makes it easy to see examples of
each report. Many firms will print this Report Pack as a reference guide for the various reports to help familiarize
them with what is available. The guides and Report Pack can also be accessed via our website at
Tabs3.com/docs.

Knowledge Base
An extensive Knowledge Base with advanced information is available for Tabs3 Software users. The Knowledge
Base contains information on Error Troubleshooting, Networking & Windows Issues, “How To” articles, and
product-related articles. You can access the Knowledge Base via the Quick Launch by searching for and selecting
“Knowledge Base,” or from your Internet browser at support.Tabs3.com.

For example, as a new Tabs3 Billing user, you may want to read some common questions regarding Tabs3
Billing. Knowledge Base Article R11103, “Tabs3 Frequently Asked Questions,” provides numerous questions and
answers on various areas of the software. The Knowledge Base is intended to work in conjunction with the Help,
by providing more focused and detailed information on certain topics.

Tabs3 Support
Tabs3 Software provide some of the best support in the industry. Service to our customers is extremely
important to us—so much so that our motto is:

Reliable software. Trusted service.
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Tabs3 Support is provided at no charge with an active subscription and is available from 8:00 a.m. to 5:00 p.m.
Central Time, Monday through Friday. If you have any questions, please feel free to call our Tabs3 Support staff
at (402) 419-2210. Email support can be requested via Tabs3.com/support.

Tabs3 Consultants
Tabs3 Software is available through a national network of over 250 consultants. Those consultants are small
independent firms that specialize in the sales, installation, training, and support of billing, financial, and practice
management software for law firms. By having consultants service all 50 states, you can work directly with a local
person familiar with Tabs3 Software, who can provide personalized on-site installation, training, and support
services. Visit our website at Tabs3.com/find-a-consultant for a consultant near you or contact our Sales staff
at (402) 419-2200.

Thank you for choosing Tabs3 Software. We look forward to serving your practice management and billing
needs with reliable software and trusted service for many years to come. Let us know how we can help you get
started with Tabs3 Software.

- 15 -

https://www.tabs3.com/support/support-email.html
https://www.tabs3.com/find-a-consultant

	Before You Start
	Installation
	Starting Tabs3 Billing

	Setting Up Tabs3 Software
	Step 1 – Configure Tabs3 Billing
	Step 2 – Add Timekeepers & Rates

	Using Tabs3 Billing
	Step 3 – Add Clients
	Step 4 – Add Fees & Costs
	Verification Lists

	Step 5 – Run Statements
	Pre-Bill Tracking

	Step 6 – Update Statements
	Step 7 – Print Accounts Receivable Report
	Step 8 – Enter Payments
	Step 9 – Matter Manager

	Resources

